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Használati útmutató Szoftver 
  

 

Az AFH LD / AFH FGT programot kifejezetten ismétlődő vizsgálatokhoz, pl. fárasztási 

vizsgálatokhoz tervezték. Az ismétlések száma a szoftverben megadható és 

kezelhető. Az adott visszafordítási pont távolságalapú (mm-ben) vagy erőalapú (N-

ben) megadható. Erő/ütem ciklusok esetén a szoftver automatikusan le tudja kapcsolni 

a vizsgálati ciklust a maximális erőcsökkentés (N-ben) megadásával. 

(Rombolásmentes anyagvizsgálat)  

A Sauter-erőmérőről a számítógépre történő adatátvitelre szolgál. A mért adatok 

XML-fájlként menthetők, és így bármely XML-kompatibilis szoftverbe importálhatók. 

A mérési adatok grafikusan is megjeleníthetők és képfájlként menthetők. 
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1 Mi újság? 

Ez a program lehetővé teszi a próbapad vezérlését az AFH LD és AFH FGT 

szoftveren belül (csak az FH és FL műszerek esetében), lehetőség van újonnan 

csatlakoztatott mérőműszerek keresésére és biztonsági leállítás meghatározására.  

Továbbá a grafika vízszintesen tükrözhető, és a határértékek túllépése esetén 

művelet határozható meg. 

 

A szoftver az LD sorozat (AFH LD-vel) és az LB sorozat (AFH FGT-vel) SAUTER 

elmozdulásmérő egységeinek használatára szolgál. Lehetővé teszi az ismétlődő 

funkciók erő vagy elmozdulás általi kiváltását. 

 

A következőt teheti: 

• Művelet végrehajtása a határértékek túllépése esetén 

• A grafika vízszintesen megfordítása 

• Csatlakoztatott eszközök keresése 

• Biztonsági megálló 

• Ellenőrző tesztpad 

• Erőcsökkentés 

2 Rendszerkövetelmények 

Az AFH LD / AFH FGT a Microsoft Windows rendszerhez lett kifejlesztve, és 

különleges követelményeket támaszt a rendszer szoftverével és hardverével 

szemben. A szoftver standard telepítőcsomagként kerül terjesztésre. A szoftver 

telepítéséről bővebben a Telepítés fejezetben olvashat. 

2.1 Hardver: 

• IBM-kompatibilis PC 

• Legalább egy soros port (RS-232) vagy USB-soros átalakító 

• 256 MB RAM 

• 10 MB szabad hely a merevlemezen 

• SAUTER tesztállvány, erőmérő és elmozdulásmérő egység LD vagy LB 

2.2 operációs rendszer: 

Microsoft Windows 2000/XP/Vista/7/8/10 (32 vagy 64 bites) 

További követelmények: NET Framework 2.0 
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3 Telepítés 

Az AFH LD és az AFH FGT standard telepítőcsomagként kerül forgalomba. A 

terméket a Microsoft Windows platformra (Windows XP, Windows 7, Windows 8, 

Windows 10) fejlesztették ki, és speciális követelményeket támaszt a rendszer 

szoftverével és hardverével szemben (lásd rendszerkövetelmények). 

 

Hogyan történik az AFH LD / AFH FGT telepítése? 

Futtassa a CD-n található "Setup" telepítőprogramot, és kövesse a telepítővarázsló 

utasításait. Windows Vista/7/8/10 alatt a felhasználói fióknak rendszergazdai jogokkal 

kell rendelkeznie. Amikor a telepítőprogram elindul, a program megkérdezi, hogy 

milyen nyelven kívánja telepíteni az AFH LD vagy az AFH FGT programot. 

 

A lehetőségek a következők: 

Német, angol 

 
 

• Válassza ki a kívánt nyelvet, és nyomja meg az OK gombot.  

 

• Ezután megjelenik a telepítővarázsló üdvözlő ablaka.   

(Ebben a példában az AFH FGT telepítése látható :)  
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• Nyomja meg a Tovább gombot a célkönyvtár párbeszédpanel 

megjelenítéséhez. Itt megváltoztathatja azt a mappát, amelybe az AFH FGT 

(vagy AFH LD) telepítésre kerül. 

  

 

• A következő ablakban lehetőség van a telepítés típusának kiválasztására. 

• A lehetőségek a következők: 

o →Alkalmazás telepítése Az alkalmazás és a megfelelő eszközlista 

telepítése megtörtént. 

o Eszközlista telepítése Csak az eszközlista van telepítve→ 
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• Nyomja meg a Tovább gombot, hogy kiválaszthassa, szeretne-e asztali és/vagy 

gyorsindító ikont létrehozni. 

  

 

• A következő ablakban megjelenik a telepítési lehetőségek összefoglalója. 

Kattintson a Telepítés gombra az alkalmazás telepítéséhez. 
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• A telepítés után lehetősége van arra, hogy a telepítési eljárás befejezése 

közben elindítsa az AFHFGT-t (vagy az AFH LD-t). 

  

• Kattintson a Befejezés gombra a telepítés befejezéséhez. 

4 Hardver telepítése 

Előkészületek:  

A SAUTER FH erőmérő mérési adatainak rögzítése előtt néhány előkészítő lépést kell 

megtenni. 

 

• Telepítse a szoftvert a számítógépére 

• Csatlakoztassa az erőmérőt (vagy a mérőállványt és az elmozdulásjelzőt) a 

számítógéphez (vagy közvetlenül a soros interfészhez vagy 

egy-egy USB-soros átalakítóval a hosszmérő eszközhöz és a mérőállványhoz). 

• Lineáris kódoló, csatlakoztassa a számítógéphez az USB-kábellel. 

• Vizsgálati állvány. soros kábellel a számítógéphez. Ha nem áll rendelkezésre 

COM 1 port, akkor RS232-USB átalakítót lehet használni. 

• Kapcsolja be az összes eszközt 

• Indítsa el a szoftvert. 
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A program indításakor a számítógép soros portjain keres SAUTER erőmérőket és 

elmozdulásmérő egységeket. Ha nem talált elmozdulásmérő egységet, akkor az 

állapotsorban egy üzenet jelenik meg. 

 

Ellenkező esetben, ha távolságmérő egységet talál, a következő üzenet jelenik meg: 

  
 

Tipp:  

Ha nem rendelkezik elmozdulásmérő eszközzel ellátott próbapaddal, akkor nem tud 

erő-elmozdulás méréseket végezni. Ekkor csak erő-idő méréseket végezhet. Ha az 

AFH FGT (vagy AFH LD) elindítása után csatlakoztatja az eszközöket, akkor be kell 

zárnia és újra kell indítania a megfelelő szoftvert, hogy újra megkeresse az összes 

csatlakoztatott eszközt. 

5 Fő jellemzők 

Az alábbiakban áttekintést talál a fontos és érdekes   

Az AFH LD / AFH FGT szoftver termékjellemzői. 

5.1 A soros interfészek kezelése 

Ez az ablak a talált interfészekre vonatkozó információkat mutatja. Itt módosíthatja a 

paramétereket. Erre azonban nincs szükség, mivel a szoftver automatikusan beállítja 

a paramétereket a perifériás eszközökkel. A helytelen paraméterek befolyásolhatják 

a szoftver funkcióit. 
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5.2 Mérőműszerek ablaka 

A mérőműszerek kezeléséhez meg kell jelenítenie a "Mérőműszerek" ablakot. Új 

mérőműszereket hozhat létre, törölheti a mérőműszereket, módosíthatja a 

tulajdonságaikat vagy ellenőrizheti a mérőműszerhez való csatlakozást. Ha a 

mérőműszerek kezelésére szolgáló ablak nem látható, akkor a View→ Encoders 

menü funkcióval jeleníthető meg. 

 

5.3 Ellenőrizze a mérőműszerhez való csatlakozást 

A mérővel való kapcsolat ellenőrzéséhez meg kell jelenítenie a "Kapcsolat 

ellenőrzése" párbeszédpanelt. Ezt megteheti a készülék ikonjára történő dupla 

kattintással, vagy a jobb gombbal a készülék ikonjára kattintva, és a kontextusmenüből 

a Kapcsolat ellenőrzése parancsot választva. 
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5.4 Ellenőrző tesztpad 

A próbapad AFH LD programmal történő vezérléséhez a "Control Test Bench" 

párbeszédpanelt kell megjeleníteni. Ezt a párbeszédpanelt a főmenü View→ Test 

Bench menüpontjával lehet megjeleníteni. 

 

5.5 Mérési sorozatok rögzítése 

A mérési sorozatok rögzítéséhez új mérési dokumentumot kell létrehoznia a Fájl→ Új 

menü funkcióval.  

Ha több mint 500 000 mérési pontot tartalmazó mérési sorozatot rögzít, további mérési 

sorozatot nem szabad megnyitni. 

6 Az összes jellemző listája 

Az AFH LD termék összes jellemzőjének listája. Az egyes funkciók részletes leírása 

a Felhasználói felület fejezetben található. 

6.1 Alapvető jellemzők 

• Több erő-idő és/vagy erő-elmozdulás mérési sorozat rögzítése  

• A soros interfészek kezelése 

• A mérőműszerek kezelése 

• A rögzített mérési adatok megjelenítése vagy kinyomtatása diagramban 

• A rögzített mérési sorozat mentése XML fájlba 

• Többnyelvű felhasználói felület (lásd telepítés) kontextusfüggő súgó funkcióval 

• Modern felhasználói felület, egyidejűleg több diagramon dolgozhat a lapok 

segítségével - lásd Felhasználói felület 
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6.2 Mérési sorozatok rögzítése 

• Több méréssorozat is rögzíthető (erő-idő és/vagy erő-elmozdulás) - (legfeljebb 

500 000 mért értéket tartalmazó méréssorozatokat külön-külön kell rögzíteni) 

• Nyomtatás és nyomtatási előnézet a megjelenített mérési adatokhoz 

• Az aktuális érték analóg kijelzése 

• A teljes méréssorozat grafikus megjelenítése zoom funkcióval 

6.3 Mentés / Exportálás 

• XML: A "Mentés" vagy "Mentés másként" parancs segítségével a mérési 

adatokat XML fájlba mentheti. 

• EMF: A "Kép mentése másként" paranccsal mentheti a mérési adatokat EMF 

fájlba. 

• PNG: A "Kép mentése másként" paranccsal a mérési adatokat PNG fájlba 

mentheti. 

• BMP: A "Kép mentése másként" paranccsal mentheti a mérési adatokat BMP 

fájlba. 

7 A felhasználói felület 

E fejezet célja, hogy rövid tájékoztatást adjon az alkalmazás használatáról és 

funkcióiról, attól függően, hogy a felhasználó hol tartózkodik. 

Ha itt nem találja meg a szükséges segítséget, kérjük, próbálja meg a "Hogyan 

tudok...?" fejezetet. 

 

7.1 A felhasználói felület alapvető elemei 

• Főmenü 

• Regisztrációs sáv 

• Állapotsor 

7.2 További ablakok és párbeszédpanelek 

• Ellenőrző tesztpad 

• Soros interfészek 

• Eszközök 

• Beállítások 

• Analóg kijelző 

• Nagy kijelző 

• Info a...Dialogról 

7.3 Bővítmények (Addins) 

A különböző eszközprotokollok értelmezését külön programrészek (add-inek) kezelik. 

Minden egyes speciális eszköztípushoz van egy add-in. 

Az aktuális kiegészítők letöltéséhez használja a "Beállítások" párbeszédpanelt. 
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8 A felhasználói felület alapvető elemei 

A következő kép az AFH LD termék felhasználói felületének alapvető elemeit mutatja. 

  

8.1 A felhasználói felület elemeinek áttekintése 

• Főmenü 

• Eszköztárak 

• Tab sáv 

• Grafikai terület 

• Tulajdonságok ablak 

• Állapotsor 

8.2 Főmenü 

A főmenü a következő almenükből áll: 

 

 

• Fájl menü 

• Mérési sorozat menü 

• Grafika menü 

• Menü megtekintése 

• Súgó menü 
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8.2.1 Fájl menü 

A Fájl menü a következő parancsokat tartalmazza: 

• Új - Új dokumentum létrehozása 

• Megnyitás - Meglévő dokumentum megnyitása 

• Bezárás - Bezárja a megnyitott dokumentumot 

• Mentés - Az aktuális dokumentum mentése a fájlnévvel. 

• Mentés másként - Az aktuális dokumentumot új névvel menti el. 

• Oldalbeállítás - Lehetővé teszi a nyomtató formátumának kiválasztását. 

• Nyomtatás - Az aktuális dokumentum kinyomtatása 

• Nyomtató előnézet - Lehetővé teszi a nyomtatandó dokumentum előnézetének 

megtekintését. 

• Kilépés - Kilép az AFH LD-ből 

8.2.2 Új 

Új parancs (Fájl menü) 

Ezzel a paranccsal új dokumentumot hozhat létre az AFH LD-ben. Egy meglévő 

dokumentum megnyitásához használja a Megnyitás parancsot. 

• Eszköztár:→  

• Billentyűzet: CTRL+N→ 

8.2.3 Nyissa meg a  címet. 

Megnyitás parancs (Fájl menü) 

Ezzel a paranccsal egy meglévő dokumentumot nyithat meg egy új ablakban. 

Egyszerre több ablakot is megnyithat. A megnyitott dokumentumok közötti váltáshoz 

használja az Ablaklista menüt. 

Új dokumentumokat az Új paranccsal hozhat létre. 

• Eszköztár:→  

• Billentyűzet: CTRL+O→ 

8.2.4 Zárja be a 

Bezárás parancs (Fájl menü) 

Ezzel a paranccsal bezárhatja az aktuális dokumentumot tartalmazó összes ablakot. 

Az AFH LD azt ajánlja, hogy a dokumentum bezárása előtt mentse el a 

dokumentumban végrehajtott módosításokat. Ha mentés nélkül zár be egy 

dokumentumot, az utolsó mentés óta végzett összes módosítás elveszik. Mielőtt 

bezárna egy meg nem nevezett dokumentumot, az AFH LD megjeleníti a Mentés 

másként párbeszédpanelt a dokumentum elnevezéséhez és mentéséhez. 

Használhatja a bezárás ikont is, ahogy az alább látható: 
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8.2.5 Mentés 

Mentés parancs (Fájl menü) 

Ezzel a paranccsal mentheti az aktuális dokumentumot az aktuális névvel. A 

dokumentum első mentésekor az AFH LD megjeleníti a "Mentés másként" 

párbeszédpanelt, hogy a dokumentumot elnevezhesse. Ha egy meglévő dokumentum 

nevét vagy könyvtárát szeretné megváltoztatni, akkor is használhatja a "Mentés 

másként" parancsot. 

• Eszköztár:→  

• Billentyűzet: CTRL+S→ 

8.2.6 Mentés alatt 

Mentés másként parancs (Fájl menü) 

Ezzel a paranccsal nevezze el és mentse el az aktív dokumentumot. Az AFH LD 

megjeleníti a Mentés másként párbeszédpanelt, amelyen megadhatja a dokumentum 

nevét. A dokumentumot az aktuális névvel mentheti el a Mentés paranccsal. 

Mentés a párbeszédpanel alatt 

A következő bejegyzésekkel megadhatja a dokumentum mentési helyét és nevét: 

• Fájlnév: Adjon meg egy új nevet a dokumentum más néven történő 

mentéséhez. Az AFH LD hozzáadja a fájlkiterjesztést a fájlnévhez, amint az a 

Fájltípus mezőben látható. 

• Hajtások: Válassza ki a meghajtót, ahová a fájlt menteni kívánja. 

• Címtárak: Válassza ki azt a könyvtárat, ahová a dokumentumot menteni 

kívánja. 

• Hálózat: Ezzel a gombbal léphet be a hálózatba. 

8.2.7 Mérőműszerek keresése 

Mérőműszerek keresése parancs (Fájl menü) 

Ezzel a paranccsal kereshet újonnan csatlakoztatott mérőműszereket és soros 

interfészeket. 

• Eszköztár:→  
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8.2.8 Oldalak beállítása 

Oldalbeállítás parancs (Fájl menü) 

Ez a párbeszédpanel lehetővé teszi a nyomtató beállításainak és a papírméretnek a 

módosítását. 

 

8.2.9 Nyomtatás 

Nyomtatás parancs (Fájl menü) 

Ezzel a paranccsal nyomtathat ki egy dokumentumot. Ha ezt a parancsot használja, 

megjelenik a nyomtató párbeszédpanel, ahol kiválaszthatja az oldalak számát, a 

nyomtatót és a nyomtató beállításait. 

• Eszköztár:→  

• Billentyűzet: CTRL+P → 
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8.2.10  Nyomtató előnézet 

Parancs Nyomtató előnézet (Fájl menü) 

Ezt a párbeszédpanelt akkor használja, ha látni szeretné, hogyan fog kinézni a 

nyomtatott dokumentum a papíron. 

 

8.3 Mérési sorozat menü 

A mérési sorozat menü a következő parancsokat tartalmazza: 

• Indulás: A mérési adatok rögzítésének elindítása 

• Megszakítás: Megszakítja a mérési adatok rögzítését 

• Kilépés: A mérési adatok rögzítésének befejezése 

• Kézi küldés: A meghatározott eszközparancsot elküldi a mérőeszköznek. 

• Idővezérelt átvitel: A meghatározott készülékparancsot rendszeres 

időközönként küldi a mérőeszköznek. 

 

Ezek a parancsok a Mérés eszköztáron is elérhetők: 

 Erő/idő mérések 

 

Erő/elmozdulás mérések 

 

8.3.1 Grafika menü 

A Grafika menü a következő parancsokat tartalmazza: 

• Megjelenítési rács: Rács megjelenítése vagy elrejtése a grafikus ablakban 

• Kép mentése másként: A képet fájlba menti (EMF, PNG, BMP). 

• Vettem: A grafikus területet a Windows vágólapjára másolja. 
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8.3.2 Menü megtekintése 

A Nézet menü a következő parancsokat tartalmazza a soros portok és mérőeszközök 

kezelésére és a programbeállítások módosítására: 

• Soros interfészek: Megjeleníti vagy elrejti a soros portok kezelésére szolgáló 

ablakot. 

• Kódolók: Megjeleníti vagy elrejti a kódolók kezelésére szolgáló ablakot. 

• Beállítások: Megnyitja a programbeállítások kezelésére szolgáló ablakot 

• Állapotsor: Az állapotsor megjelenítése vagy elrejtése 

• Tesztpad: Megjeleníti vagy elrejti a tesztpad párbeszédpanelt 

8.3.3 Súgó menü 

A Súgó menü a következő parancsokat tartalmazza: 

• Tartalom: Megjeleníti a súgófájl tartalomjegyzékét. 

• Index: Megjeleníti a súgófájl indexét 

• Keresés: Lehetővé teszi, hogy a súgófájlban meghatározott kifejezésekre 

keressen. 

• Információ: További információk az AFH LD programról. 

9 Eszköztárak 

Az AFH LD programban két különböző eszköztár található. Az egyik a főmenü 

parancsaihoz, a másik pedig a grafikus parancsokhoz. 

 

9.1 Főmenü parancsok 

• Új - Új dokumentum létrehozása 

• Megnyitás - Meglévő dokumentum megnyitása 

• Mentés - Az aktív dokumentum mentése a fájlnév alatt. 

• Nyomtatás - Az aktív dokumentum nyomtatása 

• Mérők keresése - A nemrég csatlakoztatott mérők keresése 

• Súgó - A súgófájl megjelenítése 

9.2 Grafikus parancsok 

• Másolás - A grafika másolása a Windows vágólapjára.  

• Rács - Megjeleníti vagy elrejti a rácsot a grafikus kijelzőn. 

• Zoom all - a teljes mérési sorozat megjelenítése a grafikus ablakban. 

• Nagyítás előtt - Visszaállítja az előző nagyítási beállítást. 

  



AFH_LD_FGT-BA-hu-2020.docx  19 

9.3 Ablak sáv 

Ezzel a menüvel válthat az egyes ablakok között 

 

9.4 Tab sáv 

A tabulátor sáv az aktuálisan megnyitott mérési sorozat dokumentumai közötti váltásra 

szolgál. 

 
 

A látható lapok (oldalak) között válthat, vagy eltávolíthatja (bezárhatja) őket az 

ablaklistából. 

A dokumentumok közötti váltás (az egérrel történő kattintáson kívül) a billentyűzettel 

is elvégezhető - a Ctrl+Tab billentyűkombinációval és az 

Shift+Ctrl+Tab A lap (oldal) bezárásának 

billentyűkombinációja a Ctrl+F4. A lapok sorrendje az 

egérrel történő húzással változtatható. 

Ha jobb gombbal kattint egy lapra, megnyílik egy kontextusmenü, amellyel 

megjelenítheti az aktuális mért érték analóg vagy nagyított nézetét. 

• Mérőóra: Megjeleníti az aktuális mért értéket egy analóg mérő kijelzőn. 

• Nagy kijelző: Az aktuális mért értéket nagyítva jeleníti meg egy külön ablakban. 
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9.5 Grafikus nézet 

A grafikus nézet a mérési sorozatot diagram formájában jeleníti meg. A megjelenés a 

beállítások párbeszédpanel segítségével módosítható. Ott beállíthatja a háttérszínt, a 

diagram színét stb. 

 

9.6 Állapotsor 

Az állapotsor az AFH LD / AFH FGT programablak alján jelenik meg. Az állapotsort a 

Nézet menü Állapotsáv parancsával lehet megjeleníteni vagy elrejteni. 

9.7 További ablakok és párbeszédpanelek 

Az alkalmazás további ablakokat és párbeszédpaneleket tartalmaz, amelyeket az 

előző fejezetekben nem ismertettünk. Itt találja a megfelelő fejezetek linkjeit. 

A beállítások párbeszédpanel különösen említésre méltó. 

9.8 A különböző ablakok és párbeszédpanelek listája 

• Tesztpad párbeszédpanel 

• Soros interfészek 

• Mérőműszerek 

• Beállítások 

• Információ - Dialog 
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9.9 Tesztpad vezérlő párbeszéd 

Ez a párbeszédpanel a tesztpad vezérlésére szolgál. Csak akkor érhető el, ha a 

program indításakor lineáris kódolót találtak.  

A párbeszédpanel három gombot tartalmaz a próbapad mozgásának vezérlésére, 

egyet az erőmérő nullázására, valamint egy kijelzőt, amely a próbapad mozgásának 

aktuális irányát mutatja. Továbbá itt jelenik meg a próbapad pozíciója és számított 

sebessége is. 

Tipp: 

Ha az AFH LD / AFH FGT elindítása után csatlakoztat eszközöket, a programot be 

kell zárni és újra kell indítani, vagy a mérőeszközök keresése menüpontot kell 

végrehajtani a mérőeszközök felismeréséhez. 

9.10 Soros interfészek 

Ez az ablak a számítógépen rendelkezésre álló összes soros interfészt mutatja. A 

beállítások megtekintéséhez vagy módosításához ki kell választani a megfelelő 

interfészt. Az alsó ablakban ezután a megfelelő beállítások módosíthatók. 

 



22  AFH_LD_FGT-BA-hu-2020.docx 

9.11 Mérőműszerek 

Ez az ablak az összes létrehozott eszközt megjeleníti. Egy adott eszköz 

tulajdonságainak módosításához ki kell választani az eszközt, és a kívánt 

tulajdonságokat be kell állítani. Az ablakban jobb egérgombbal kattintva új 

mérőeszköz adható hozzá. 

 

 

9.12 Beállítások 

A beállítások párbeszédpanel az a hely, ahol az alkalmazás paraméterei 

módosíthatók. Egyes paraméterek (pl. az eszköz tulajdonságainak módosítása) 

automatikusan elmentésre kerülnek, mások (a diagram megjelenítésének 

megjelenése) pedig az AFH LD / AFH FGT eszköztárakon keresztül is elérhetőek. Az 

alkalmazás legfontosabb beállításai azonban ebben a párbeszédpanelben találhatók. 

Ez a párbeszédpanel a paraméterek tartalma és fontossága szerint különböző 

kategóriákra oszlik (Grafikus, Megjelenítés és Add-In). Ebben a fejezetben az egyes 

kategóriák és az egyes paraméterek leírását találja. 



AFH_LD_FGT-BA-hu-2020.docx  23 

9.13 Grafika 

 
A grafikus kijelző hátterének, a nyomvonal színének vagy a rács színének 

módosítása. 

Grafika - Az Anti Alias funkció engedélyezése/letiltása a nyomvonal minőségének 

javítása érdekében. 

Trace - rács be- vagy kikapcsolása, a mérési pontok közötti vonalak be- vagy 

kikapcsolása, a mért értékek pontszimbólumként való megjelenítése. 

 

9.13.1 Megjelenítés 

• Mérőműszer - Állítsa be a határérték színét, a skála színét és az analóg 

mérőműszer tűjének színét. 

• Nagy kijelző - A nagy kijelző háttérszínének, betűtípusának és betűszínének 

kiválasztása. 
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9.13.2  Add-in 

• Letöltés - A legújabb bővítmények letöltése a mérőműszer protokolljainak 

értelmezéséhez (internetkapcsolat szükséges). 

• Törlés - A nem szükséges bővítmények törlése a merevlemezről. 

 

9.13.3 Analóg kijelző 

Ez az ablak az aktuális mért értéket jeleníti meg egy analóg mérőeszköz formájában. 

A határérték-tartományt a beállítások párbeszédpanel segítségével más színnel lehet 

jelezni. 

 

Az ablak bekapcsolásához nyomja meg a jobb egérgombot a mérési sorozat felett. 
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9.13.4  Megnagyobbított kijelző 

Ez az ablak az aktuális mért értéket nagyított formában jeleníti meg. A betűtípus és a 

szín a beállítások párbeszédpanel segítségével módosítható. 

 

10 AFH FGT / LD Súgó menü: Hogyan tudok...? 

Ebben a súgó fejezetben példákat talál, amelyek segítenek megérteni az AFH LD / 

AFH FGT termékkel elvégezhető feladatokat. Az alábbi lista tartalmazza az ezekre a 

példákra mutató linkeket. 

 

• Mérési eredmények exportálása: Mérési sorozatokat exportálhat EXCEL-be 

 

10.1 Soros interfészek kezelése 

A program megjeleníti az összes létező soros interfészt. Egy interfész beállításainak 

módosításához válassza ki az interfész ikonját, majd állítsa be a megfelelő értékeket 

(baud-ráta, paritás stb.) az ablak alsó részében. Ha a soros portok kezelésére szolgáló 

ablak nem látható, akkor a View->Serial ports menü funkcióval jeleníthető meg. 
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10.2 Mérőműszerek kezelése 

A program megjeleníti az összes létrehozott mérőműszert. Ebben az ablakban új 

mérőműszereket hozhat létre, törölhet mérőműszereket, módosíthatja a beállításaikat, 

vagy ellenőrizheti a mérőműszerhez való csatlakozást. Ha a mérőműszerek 

kezelésére szolgáló ablak nem látható, akkor a Nézet->Mérőműszerek menü 

funkcióval jeleníthető meg. 

10.3 Mérési sorozat 

A mérési sorozatok rögzítéséhez a következő lépéseket kell végrehajtania: 

• Hozzon létre egy új mérési sorozat dokumentumot a főmenü Fájl->Új 

menüpontjával. 

• Válassza ki azt a mérőműszert, amelytől a mért adatokat kapja. 

• A mérőeszköz és a mérés beállításainak módosítása 

• Váltson a mérési menübe 

• Mérés indítása, mért értékek rögzítése kézzel vagy idővezérelt módon 

• A mérés leállítása és az adatok mentése vagy nyomtatása 

• A mérési sorozat dokumentumának lezárása 
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10.4 Mérési sorozat felvétele 

10.4.1 Új mérési sorozat dokumentum létrehozása 

 

10.4.2  Válassza ki a mérőeszközt az eszközlistából 

10.4.3  A mérő és/vagy a mérés tulajdonságainak módosítása az Ön igényeinek 

megfelelően 

Az eszköz egyetlen megváltoztatható tulajdonsága az előjel inverziója. Ha ez a 

tulajdonság igenre van állítva, a mért érték előjele megfordul, pl. ha a mérő 40 N-t küld, 

a mért érték -40 N-re változik. Az összes többi eszköztulajdonságot az 

eszköztulajdonságok ablakból vesszük át. 
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10.4.4  A következő mérési sorozatok tulajdonságai módosíthatók: 

• A határértékre történő beavatkozás lehetővé teszi, hogy a próbapad megállítsa 

vagy visszafordítsa a próbapadi mozgást, ha a berendezés határértékei 

túllépésre kerülnek. 

• A dátum/idő automatikusan beíródik a mérés kezdetén. 

• Az eszközhatárok lehetővé teszik, hogy csak az előre meghatározott 

sávszélességen belüli mért értékeket rögzítsék. 

• A vízszintes tükrözés lehetővé teszi a mért értékek grafikus nézetének 

vízszintes tükrözését. 

• A mérés típusa lehet erő-idő, erő-elmozdulás vagy memória kiolvasás 

• A mérési sorozat felső határa (csak akkor aktív, ha az eszközhatárok igenre 

vannak állítva) 

• A mérési sorozat címe a mérési adatok mentéséhez és megjelenítéséhez 

• A mérési sorozat alsó határa (csak akkor aktív, ha a készülékhatárok igenre 

vannak állítva). 

• Az út megfordítása az útértékek megfordítására szolgál (csak akkor látható, ha 

a mérés típusa erő/út beállításra van beállítva). 

• Időintervallum, amelyen belül a készülék a mért értéket kérő parancsot elküldi 

(Ez a beállítás befolyásolja a hosszú távú méréseknél a tárolt mért értékek 

számát és így a maximális vizsgálati időt is. Az erő/elmozdulás vagy erő/idő 

mérésekhez legfeljebb 500 000 mért érték tárolható) 

10.4.5  Váltson a mérési menübe 

 

 
A mérési menübe való váltás után méréssorozatokat rögzíthet. 

 A mérés típusától függően ez a menü kissé másképp néz ki: 

Force Time 

Erő-távolság 
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10.4.6  Mérési adatok exportálása EXCEL-be 

A mérési adatok EXCEL-be (vagy bármely más XML-kompatibilis szoftverbe) történő 

exportálásához csak a dokumentumot kell menteni a Mentés vagy a Mentés másként 

funkcióval. A fájl ezután a Megnyitás paranccsal (Fájl menü) betöltődik az EXCEL-be, 

a betöltéskor az XML dokumentumtípust választva. 

10.4.7  Eszköz létrehozása 

 
Új mérőeszköz létrehozásához kattintson a jobb gombbal a mérőeszköz ablakában a 

kontextusmenü megjelenítéséhez. Ezután válassza az Új menüpontot. Megjelenik a 

Mérőeszköz létrehozása párbeszédpanel. 

Válassza ki az eszköztípust a listából, és adja meg az eszköz nevét (vagy fogadja el 

az alapértelmezett nevet), majd nyomja meg az OK gombot. A létrehozott 

mérőeszköznek most már meg kell jelennie a mérőeszköz ablakban. 
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10.4.8  Eszköz törlése 

Egy mérőeszköz törléséhez kattintson a jobb gombbal a mérőeszköz ikonjára a 

kontextusmenü megjelenítéséhez. Ezután válassza a Törlés menüpontot. A törlést 

megerősítő üzenet jelenik meg. 

A megerősítéshez nyomja meg az üzenetablakban az Igen gombot. 

 

10.4.9  A készülék beállításainak módosítása 

Az összes eszközspecifikus beállítás ebben a tulajdonságok ablakban módosítható. A 

bal oldalon a tulajdonság neve, a jobb oldalon pedig a megfelelő tulajdonságértékek 

találhatók. Az alsó területen a tulajdonság rövid leírása jelenik meg. 
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A mérőműszerek a következő jellemzőkkel rendelkeznek: 

• Eszköz típusa 

• Max., Min. mérési tartomány 

• Eszköz neve 

• Az eszköz által küldött adatbájtok száma   

• Olvashatóság 

• Előjel megfordítás (a kapott mért értékek inverzek)  

• Port (COM-port, amelyhez az eszköz csatlakozik) 

• Egység 

• Biztonsági megálló 

• Készülékparancs stabil mért értékhez 

10.4.10 A készülék csatlakozásának tesztelése 

Ebben a párbeszédpanelben ellenőrizhető, hogy van-e kapcsolat az adott 

mérőműszerrel, és hogy a műszer hibátlanul kommunikál-e az AFH-FGT / AFH LD-

vel. 

A kapcsolat létrehozásához nyomja meg a Csatlakozás gombot. A piros LED jelzi, 

hogy a COM-port hiba nélkül megnyílt-e. Jobbra tőle megjelennek az aktuális 

kapcsolati paraméterek. 

Amikor a műszer adatokat küld, az adatok hexadecimális formában és ASCII 

karakterek formájában jelennek meg az ablakban (A műszertől kapott adatok). 

Az Adatok törlése gombbal törölheti az ablakból a kapott adatokat.  

A parancs küldése gomb segítségével küldje el a kódoló parancsot a kódolónak. 

Mielőtt bezárná ezt a párbeszédpanelt, a leválasztás gomb megnyomásával szüntesse 

meg a kapcsolatot a mérőműszerrel. 
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10.4.11 Interfész tulajdonságainak módosítása 

 

Az összes interfész-specifikus beállítás ebben a tulajdonságablakban módosítható. A 

bal oldalon a tulajdonság neve, a jobb oldalon pedig a megfelelő tulajdonságértékek 

találhatók. Az alsó területen a tulajdonság rövid leírása jelenik meg. 

A soros interfész a következő tulajdonságokkal rendelkezik: 

• COM port száma 

• Baud rate (az átviteli sebesség bit/sec-ben)  

• Adatbitek száma (adatbitek száma bájtonként) 

• Handshake protokoll 

• Paritás 

• Stopbitek száma 

10.4.12 Ellenőrző tesztpad 

A próbapad párbeszédpanel lehetővé teszi a próbapad mozgásának vezérlését és az 

erőmérő nullázását. Csak akkor jeleníthető meg, ha a program indításakor találtak 

elmozdulásjelzőt. Ellenkező esetben a szóban forgó menüpont inaktív.  

10.4.13 A próbapad mozgásának vezérlése  

Ezzel a három gombbal a próbapadot felfelé vagy lefelé mozgathatja, illetve 

leállíthatja. A mozgatás kijelzője az aktuális mozgatási állapotot mutatja.  
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10.4.14 Állítsa a mérőműszert nullára  

Ezzel a gombbal állíthatja nullára a mérőműszert. 

10.4.15 A próbapad aktuális mozgásállapotának megjelenítése  

Ez a mozgásjelző mutatja, hogy a próbapad felfelé vagy lefelé mozog, vagy 

nyugalomban van. 

11 AFH LD: A lineáris potenciométer kalibrálása 

A mérés megkezdése előtt a lineáris kódolót kalibrálni kell, ha az AFH LD szoftvert 

használja. Ehhez egy 100 mm hosszú, kalibrálásra szolgáló referencia rúd tartozik a 

szállításhoz. 

 
 

A kalibráláshoz a következő eljárást kell követni: 

• A Nézet --> Beállítások menüpont alatt a következő lapot éri el. 

 

 

• A megfelelő lineáris kódolót a Kódolók menüpont alatt kell kiválasztani. A szám 

azt a mm-ben megadott hosszúságot írja le, amelyhez a lineáris kódoló 

használható.  
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• A kalibrálás megkezdéséhez a próbapadot a legalacsonyabb helyzetbe kell 

állítani.  

 

• Ezután nyomja meg az érték elfogadása gombot. 
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• Ezután a próbapadot több mint 100 mm-rel felfelé mozgatjuk. Amikor a 

próbapadot lassan leengedjük, a referencia rudat úgy helyezzük az alsó 

állítógyűrűre, hogy a végálláskapcsoló kikapcsolja a motort, amikor az alsó 

végálláskapcsoló eléri a 100 mm-t. A végálláskapcsoló lekapcsolja a motort. A 

próbapad mozdulatlanul áll (vigyázat: összenyomódás veszélye!) 

• Nyomja meg az érték elfogadásához. 

• Nyomja meg a Befejezés kalibrálás gombot. Vegye ki a referencia rudat.  

 

• Nyomja meg az OK gombot. A kalibrálás befejeződött. 

 

Az állapot az alábbiakban látható. 

Az értékek tárolódnak és a következő programindításkor rendelkezésre állnak, amíg 

új kalibrálás nem történik. Ezt hosszabb szünet vagy eltérések esetén javasoljuk egy 

új kalibrálás elvégzésére. Most már minden készen áll az első mérésre. 
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12 Első mérés (ciklusmérés) 

• Új mérési sorozat dokumentum létrehozása 

 

• Válassza ki a használni kívánt mérőeszközt a listából (ha a készülék nem jelenik 

meg, a Mérőeszköz ablakban kiválaszthatja. 

ablakban. 

12.1 Állítható paraméterek: 

• Mérőeszköz: itt a mérőeszköz a legördülő menüből választható ki. 

• Biztonsági megállás: itt lehet beállítani egy értéket, amelynél a próbapad megáll 

(ne állítson be nagyobb értéket, mint a használt erőmérő maximális terhelése). 

• A fordított előjel a  görbe megjelenítési irányának megváltozását okozza. 

• Akció a határon: itt a mozgás irányának megfordulását kényszerítik ki, 

vagy egy bizonyos távolság elérésekor (Invert path Path→ Path constant) 

 vagy egy erő elérésekor (erő megfordítása→ Erőállandó). 

• Ciklusok száma: a ciklusok száma itt kerül meghatározásra. Nagy értékek 

(>10000) esetén a szoftver lassúvá válhat. 

• Eszközhatárok: ebben a példában: Igen. Itt általában azt határozzák meg, 

hogy használnak-e határértékeket 

• Vízszintes tükrözés: a nyomvonal menetét tükrözi. 

• Mérési típus: itt választhat az erő-elmozdulás, az erő-idő és a memória 

kiolvasás között. A nyomóerő mérések mínusz értékekkel jelennek meg, pl. -

50N 

• Felső határ: Az erő vagy elmozdulás értéke itt kerül megadásra. 

• Cím: a mérést itt lehet megnevezni  

• Alsó határ: Az erő vagy elmozdulás értéke itt kerül beírásra. 
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• Fordított: igen vagy nem 

• Időintervallum: itt állíthatja be a mérési adatok szoftveren belüli rögzítésének 

értékét. (Időintervallum, amelyben a mért értékeket az erőmérő eszközről 

lekérik) 

 

Az időintervallum beállítása, valamint a ciklusok száma befolyásolja a hosszú távú 

méréseknél a tárolt mért értékek számát és így a maximális vizsgálati időt is. Az 

erő/távolság vagy az erő/idő mérésekhez legfeljebb 500 000 mért érték tárolható.  
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• Ezután folytassa a  mérést a . Kattintson a jobbra mutató nyílra.  

 
 

• Nyomja meg a gombokat felfelé vagy lefelé a próbapad mozgásba hozásához, 

amely ezután elküldi a mért adatokat a szoftverbe.  
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• A ciklusok számának elérésekor a mérés befejeződik. 

 
 

Ha a mérés befejeződött, a mérés tetszőleges helyen tárolható.  

Ezután a szoftvert bezárja, és az összes eszközt kikapcsolja.  

 

13 További információk 

További támogatási források 

 
Itt találja meg az egyéb segítségforrásokra mutató linkeket (használati utasítások, 

műszaki adatlapok stb.).  

13.1 AFH LD / AFH-FGT dokumentáció 
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13.2 AFH-LD / FGT - Licencszerződés 

Eltérő megjegyzés hiányában az AFH-LD vagy AFH-FGT csomagban található összes 

dokumentáció és szoftver a SAUTER GmbH szerzői jogi védelme alatt áll.  

Szerzői jog (c) 2009-2012 SAUTER GmbH. Minden jog fenntartva.  

13.3  Licenc 

Ez a termék egyfelhasználós licencként kerül forgalomba (lásd a licencszerződést). 

 

13.4  Felelősségi nyilatkozat: 

Ez a szoftver "úgy, ahogy van", mindenféle kifejezett vagy hallgatólagos garancia 

nélkül, és mindenféle garancia nélkül, ami a szoftver adott célra való alkalmasságát 

illeti. A kiadó semmilyen körülmények között nem vállal felelősséget a szoftver 

használatából eredő bármilyen jellegű kárért.  

 

13.5  Engedélyek: 

1. Ezt a terméket vagy egy korábbi verziót telepíthet ugyanarra az operációs rendszerre, 

és használhatja egy példányát egyetlen számítógépen. A Termék másolatát tárolhatja 

vagy telepítheti egy tárolóeszközre, például hálózati szerverre is, de kizárólag a 

Termék hálózaton keresztül történő telepítése vagy használata céljából, az Ön 

tulajdonában lévő más számítógépeken. Ebben az esetben azonban minden egyes 

felhasználó számára, aki a tárolóeszközön keresztül hozzáfér a Termékhez és 

használja azt, licencet kell vásárolnia. A Termékre kiadott licenc nem használható 

egyidejűleg több számítógépen vagy több felhasználó által egyidejűleg ugyanazon 

műveletben, vagy más módon nem osztható meg közöttük. 

13.6  Korlátozások: 

1. A terméket nem szabad módosítani, visszafejteni, dekompilálni vagy szétszerelni.  

2. A terméket nem adhatja bérbe, nem adhatja bérbe és nem adhatja kölcsön senkinek. 

Ez a licenc automatikusan megszűnik, ha Ön nem tartja be a jelen 

Licencszerződésben meghatározott bármelyik feltételt.  

 

Sauter GmbHE mail  

: info@sauter.eu 

http://www.sauter.eu;  

www.kern-sohn.com 

Szerzői jog © 2009-2012 SAUTER GmbH. Minden jog fenntartva.  
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